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5. PHoTostudio

For the first time, PHOTOstudio makes it possible to edit and design images within one and the same 
module. This has been made possible by combining the CREATIVE and PICTUREstudio modules of the 
predecessor version (SPECTRUM 3.0) into PHOTOstudio in SPECTRUM 4.0. This makes visualising vari-
ants much easier and faster.

PHOTOstudio allows the editing of users’ photos, example images or planning documents. Pictures can 
be retouched, masked and then designed with the full range of colours and materials in the software.

Wizard
The first time you open PHOTOstudios an options window will appear where you can select various ac-
tions directly.
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On the one hand, you can select an example image from the SPECTRUM 4.0 image database in order to 
load this directly into PHOTOstudio for variant design. 

Or you can import an image from your PC or an external data carrier to SPECTRUM 4.0 in order to prepare 
this for design and then complete the design. 

Click “PHOTOservice” directly to have one of your own images prepared for design (see chapter 9 for 
more information on PHOTOservice).

You can get further information on the individual options by moving the mouse over the respective options 
buttons.

If you do not want the wizard to be shown every time you open PHOTOstudio, remove the tick next to 
“Show this dialogue window every time the program is started”. Alternatively, you can control the display 
via the main navigation under “Extras”>“Options” by changing from “Activated” to “Deactivated” in the 
“Display wizard” field.

note: If you load an image directly by double-click from the EXPLORER into PHOTOstudio, the PHOTO-
studio wizard is bypassed automatically.

5.1 menu bar

The PHOTOstudio menu bar shows symbols that can be used to help you carry out the following actions: 
import own images, load existing database images for design, save, export and/or print variants.

5.1.1 import personal image

If you would like to import a personal image for editing and design to PHOTOstudio, click the “Import new 
image” button on the menu bar (or go via the main navigation “File>“New”). A window opens which you 
can use to select an image from your hard drive or an external data carrier. Confirm image selection by 
clicking “Open”. The SPECTRUM 4.0 project window is opened. In this you can assign the image to an 
existing project by selecting a project folder or create a new project folder (see chapter 4.2.1 “My projects” 
on how to create a project). Give the image a new “variant name” or keep the name shown. Click “Save” 
and the image will be loaded into PHOTOstudio directly for editing. Read chapter 5.2 “Editing images and 
preparing them for design” on how to create your design.

note: Make sure that the images or planning documents to be imported are available as jpeg, TIFF or 
PNG files since they will not be able to be loaded in SPECTRUM 4.0 otherwise. You must also make sure 
that your images have a resolution of at least 1920 x 1440 pixels with 150 dpi so that the variants can be 
printed in sufficient quality.

09/2010 - Caparol SPECTRUM 4.0 - User Manual



5. PHOTOstudio

34

5.1.2 load existing database image

In order to load an existing image from the database, click the “Open” button in the PHOTOstudio menu 
bar, (or: main navigation “File”>“Open”). The EXPLORER library window is opened. Choose the image you 
want from your own projects or the example images by mouse click (see chapter 4.2.1 “Database images” 
on image selection) and confirm by pressing “OK”.

5.1.3 save variant

After you have designed an image, save the variant by clicking the “Save” symbol (main navigation 
“File”>“Save as”). The project window is opened where you can assign the image to an existing project 
or prepare a new project folder for it (see chapter 4.2.1 “My projects” for information on how to create a 
project). Give your image a new variant name.

note: We recommend saving the image from time to time during editing and designing to prevent your 
work being lost if the program or computer crashes (shortcut: Ctrl+S; main navigation “File”>“Save”).
You can initiate automatic saving via the main navigation to ensure regular data saving. In 
“Extras”>“Options” you can determine how often regular automatic saving should take place in the PHO-
TOstudio module in an extended settings window. Save the changed settings by clicking “Apply”.

5.1.4 export variant

You have the possibility of saving your variant as a jpeg, TIFF or PNG file on your PC or an external data 
carrier by clicking the “Export variant” symbol. Give the variant a file name in the dialogue window that 
opens, choose the target location and click “Save”. This enables you to send the variant image as an e-
mail attachment to customers, for example, or use it further in other applications.

5.1.5 create PDF

Click the “Print PDF” button on the menu bar (main navigation “File”>“Print”) to print the variant currently 
being shown. The dialogue window that opens gives you the choice between a letter or full screen layout 
for PDF creation. In addition, a material list of all the colours and materials used including thumbnails and 
exact product description can be added and printed out. 

letter
In addition to an area for your customer’s address data, the letter layout includes a thumbnail view of your 
variant. This is the option you should choose if you want to send the variant by post.
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Full screen
The full screen layout presents your variant in maximum size on a DIN A4 sheet. 

Mark the “Letter” or “Full screen” mode in the top right-hand area of the window and enter the required 
address data of the recipient (the address data will only be faded in when letter layout is selected). In addi-
tion, you can compose a brief explanatory text about the colour design. 
The material list is added to the layout by default, but can be deselected by removing the tick.

You can also embed your own logo which will then appear in the letterhead. To do this, click “Browse” to 
select your logo from your PC or an external data carrier and load it in SPECTRUM 4.0. The selected logo 
can then be seen as an example in the “Embed personal logo” window. Click “Delete logo” to remove it.

note: Make sure that your logo is available as a jpeg, TIFF or PNG file so that you can use it in SPEC-
TRUM 4.0. 

When you have entered all the necessary information about your variant, click “Print” to create a PDF file 
of the variant that can be saved or printed as required.

5.16 Print variant

If you would like to print a variant without creating a PDF file, click the “Print” symbol (“Print”) in the menu 
bar. The print window on your PC will open. Choose the printer and print settings you require for the print-
out. The variant will then be printed as an image without text and logo.

5.17 view buttons

Zoom in
Click this button to enlarge the size of the image in the workspace.

Zoom out
Use this button to reduce the size of the image in the workspace.

Fit to screen
You can adapt the size of your image to fit the workspace with the aid of this button.
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enlarge workspace
This button fades out the design and tool tabs, thus enlarging the workspace.

note: The functions described here can also be used via the main navigation item “View”.

5.2 edit images and prepare them for design

When you have loaded a new image to SPECTRUM 4.0, you have to prepare it for later design by retouch-
ing the image if necessary and defining objects, surfaces and grids for later colour/material design.

The PHOTOstudio tools are on the right in the workspace. Fade these in or out by clicking the toolbox.

5.2.1 objects

create objects
To be able to design a façade or interior using different colours and materials, individual objects have to be 
defined first. You can specify and review the objects for an image in the “Objects” tab on the left in PHO-
TOstudio.
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Create a new object by clicking the “New” button . The “Object name” window opens where you can give 
the object a characteristic name e.g. ceiling, left wall, skirting board etc.. Then click “Save” and the new 
object will appear in your objects list. If you click “Cancel” no object will be created. 

As soon as you have created an object, the “Create area” tool is activated so that you can create an area 
immediately by clicking in the image (see chapter 5.2.3 “Tools: Area” on how to give objects areas).

note: You can create any number of objects per image. 

To change the name of an object again, double-click the respective object or right-click the object and 
choose “Rename object”. You can change the name in the dialogue window that opens.

remove object
Remove an object by marking it through a mouse click and then clicking the “Delete” button. If you answer 
the query dialogue “Yes” the object is deleted completely from the list (including all area, grid and colour 
information).
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5.2.2 Tools: Picture optimisation

After you have opened an image in the PHOTOstudio you can adapt it to the required position and size us-
ing the picture optimisation option.

rotate
Use the “Rotate” function to rotate your image in the workspace. Every time you click the “Rotate” button 
your image will rotate a further 90° clockwise.

crop
Use the “Crop” function to cut out a section of the image for design. When you click the “Crop” tool, a 
window will open showing a preview of your image and the cropping options “Offset” and “Dimension”. 
The blue clipping frame shows the section currently selected.
To define the section, click into the thumbnail view of the image and drag the frame to the size required for 
cropping, keeping the left-hand mouse button pressed. Then click “Apply” to crop the image according to 
this specification.
Alternatively you can cut out an image section by making exact entries in the cropping options “Offset” 
and “Dimension”. A section can be moved along the X and Y-axis using “Offset”. The higher the value 
given for X or Y-axis, the more the selected area is moved to the right (X-axis) or downwards (Y-axis).
You can vary the size of your section by entering width and height in the “Dimension” section.

note: You can read off the height and width of your image on the rulers in the workspace. These dimen-
sions are the starting point for determining height and width of the section you require.
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5.2.3 Tools: area

give objects areas
After every object has been created, the exact area for later colour and material design must be defined. 
Any number of areas can be created within an object. These are given the same colour or material assign-
ment during design.

When defining areas, you can choose between creating an “Area” or a “Grid”. Choose “Area” to colour the 
object. If materials are to be added to the design later (e.g. spatula techniques, wood, tiles, ...) a “Grid” is 
necessary in addition to the area for reasons of perspective.

note: A grid can only be created where an area is already available.

Create area
To create a new area within an object, first choose the respective object. Then click the “Create area” tool. 
Begin by defining corner points for your area through mouse clicks - the tool automatically connects up 
the points you set.

To close the area, double-click the starting point for your area when setting the last point with the mouse. 
(The area has been closed correctly when the line for preparing areas no longer follows the mouse pointer.) 
Alternatively you can have the last part generated automatically by double-click when setting the last point 
but one.

note: If you would like to remove individual points during creation of an area, clock the “Backspace” but-
ton on your keyboard. The point created last is deleted with every click. You can then continue completing 
the area.

After closing one area, you can define further areas within the same object in the same way. To do this, 
click the “Create area” tool again and define your area as described above.

note: Please note that all areas within one object are assigned the same colour and materials during de-
sign.

If you would like to cut a polygon out of an existing area, e.g. allow for a window in a façade, create a new 
area within the existing area using “Create area”. The intersection area of doubled areas is cut out.
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Delete area
To delete an area, choose the “Delete area” tool and click a line/point on the area you would like to re-
move. The required area is deleted when you confirm your selection by clicking “Yes”.

Move points/lines
When you have created an area you can optimise its position by moving points and/or lines, adding new 
points or deleting existing points.

note: The “Move” tool is automatically selected after an area has been created.

Move individual points by selecting the “Move” tool, clicking a point (active points are red, inactive points 
are green) and dragging this to the position you require while keeping the left-hand mouse button pressed. 

Move individual lines by selecting the “Move” tool, clicking a line (non-selected lines are blue, selected 
lines yellow, the points adjacent to the lines are red) and drag these to the required position while keeping 
the mouse button pressed. The line end points are moved parallel and the adjacent lines distorted accord-
ingly.

In order to move all the areas within an object click the image outside the polygons to deactivate all areas. 
Press the “A” key on your keyboard to “select all” and then move the mouse with the left-hand mouse but-
ton and “Ctrl” key pressed.
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Add points
When you activate the “Add point” tool and then click on a line within an area with the mouse pointer, a 
new point is set at this spot. You can see that you are on the line with the mouse pointer when this turns 
white. You can position the newly created points using the “Move” tool.

Delete points/lines
Activate the “Delete point” tool to remove individual points. When you then click on a point it will be de-
leted immediately. The area remains closed since the adjacent points and/or lines are connected automati-
cally.

Alternatively you can remove individual points and lines within an area by marking the required points and/
or lines (active points are red, active lines yellow) and then clicking the “Del” key on your keyboard. The 
respective selection is removed immediately and adjacent points and/or lines are connected automatically 
- the area remains closed.

note: If the starting point or end point of an area is deleted, the area is opened and the “Create area” tool 
is selected automatically so that you can set points again.

note: To define areas as exactly as possible, use the navigator’s “Zoom” function at the bottom right edge 
or the scroll bar of your mouse (see chapter 5.3.3 on how to zoom with the navigator).
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5.2.4 more tools - area

magic wand
You can use the “Magic wand” tool to define a selection within an active area that can be filled with colour 
or material during design (e.g. if you would like to leave a tree in front of a façade out of the area). 
A numeric value from 0-99 regulates the sensitivity with which the magic wand automatically recognises 
similar colour nuances. This value is set to 15 as standard. The lower the numeric value, the more sensitive 
the magic wand reacts to similar colour nuances and the selected colour area is restricted.

To make a selection, click a point within your area which is to be included in the selection. The magic wand 
automatically marks all the parts of the area with a similar brightness (depending on the brightness set-
ting). The magic wand can add or remove areas by clicking “+” or “-” (alternatively: click the left mouse 
button with the “Shift” key pressed to add further areas).

note: If you have already made a selection with the magic wand and click in the area again, the selection 
previously made is “overwritten” and no longer exists.

note: The “Draw mask” tool can be used to correct unclean areas or for the manual enlargement of your 
selection.

Draw mask
The “Draw mask” can be used like a brush to draw a free area and thus create a selection. You can create 
the selection freehand, extend a selection previously made with the magic wand or correct unclean selec-
tion areas created by your magic wand.

note: To draw straight lights set the line’s starting point by clicking the left mouse button and then keep 
the “Shift” key pressed as you set further points. 
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note: In contrast to the magic wand, where a selection can only be created within the active area, the 
mask tool can be used to mark the whole image. 

rubber
Red selection areas that you have created using “Magic wand” and/or “Draw mask” can be deleted again 
too. To do this, select the “Rubber” tool and correct your mask accordingly. Like the “Draw mask” tool, the 
rubber can be used on the whole image both inside and outside marked areas.

Tool points
There are four differently sized tool points available in sizes 8, 16, 32 and 64 for use of the “Rubber” and 
“Draw mask” tools. 

Delete mask
This function can be used to completely remove the selection created by the “Magic wand” and/or “Draw 
mask” functions within the object.
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5.2.5 Tools: grid

create grid
So that a component can be designed not only with colour, but also with materials (e.g. spatula tech-
niques, fabrics, carpets, tiles, ...) in correct perspective and scale, a so-called grid is required in addition to 
the area. The grid is superimposed directly on the area as a reference and provides information about the 
size and type of perspective distortion for the respective component.

note: For a grid to be created, at least one area must exist within a component (see chapter 5.2.3 “Tools: 
Area” for how to create areas).

To create grids in different components, choose the respective component in the “Component” tab first 
and then click “Grid” within the “Component tools” tab on the right of the screen.

note: Only one grid can be created per component. For this reason you should make sure that all the 
component areas that you would like to assign materials to are on the same perspective level. Create 
separate components with area and grid for wall surfaces with different perspective distortion.

Create a grid within a component by selecting the “Create grid” tool. A standardised grid will appear in the 
centre of the image - the program automatically changes to “Move” mode, in which you can move the grid.

note: Always create your grid slightly larger than the actual area so that your material will be visible over 
the whole area of your component.

move grid
Move the grid into the right position and perspective by selecting the “Move” tool and moving the corner 
points or outer lines of the grid to the required position with the left mouse button pressed.
Reference lines are used as support for the creation of the grid with the correct perspective, these will help 
show you the current vanishing point of the grid.
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To move the whole grid, click the image outside the grid - this will deactivate all areas. Press the “A” key 
on your keyboard to “select all” and then move the mouse with the mouse button and “Ctrl” key pressed 
to move the grid.

Delete grid
To delete a grid that has been created, click the “Delete grid” symbol and confirm deletion by clicking 
“Yes” in the dialogue window that opens.

adapt grid dimensions
For the materials you add during design to be represented as realistically as possible in terms of size 
dimension, the grid has to be assigned the dimensions that correspond to the original component area. To 
do this, change the standard dimension setting from width 350cm x height 250cm accordingly by enter-
ing the real dimensions. An indication of the correct takeover of the new dimensions is a grid check on the 
basis of a test structure (see chapter 5.2.8 “Colour settings” for grid test structure). 
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5.2.6 more tools - grid

The additional tools in the “Grid” are offer you further possibilities for creating and editing grids.

corner grid 
This tool provides a grid that corners can be added into. This enables materials to be continued around 
corners (e.g. with corner pillars or wall corners that are to be decorated with the same material).

1. Click the “Corner grid” tool
2. You are now automatically in “Move” mode and can move the corner points of the grid into the required 
position.
3. Choose “Add line” to add an edge line to the grid. Then click the respective position on the upper or 
lower boundary line of the grid. (Further lines are added when you click again at another spot on the grid 
boundary lines.)
4. Activate the “Move” tool and move the added lines to the required position by dragging an end point 
with the left mouse button pressed
5. Always take all areas into account when entering the dimensions
6. Finally check your “corner grid” on the basis of a test structure (see chapter 5.2.8 “Colour settings” for 
information about test structure for grids)

note: To delete the lines you have added, click the “Delete line” symbol and then click the line in the grid 
that you would like to remove. The line is deleted. To continue the grid around several corners, repeat the 
addition of lines to create further corners.

Bezier grid 
Choose this tool for a grid that can be used to generate curves. This allows materials to be placed continu-
ally around curves (e.g. pillars or curved walls).

1. Click the “Bezier grid” tool
2. You are now automatically in “Move” mode and can drag the corner points of the grid into the required 
position
3. To curve the grid, click the lines (not the points) on the grid and drag these in the direction you want, 
keeping the left mouse button pressed.
4. Enter the dimensions for your area
5. Finally check your “bezier grid” on the basis of a test structure (see chapter 5.2.8 “Colour settings” for 
information about test structure for grids)

09/2010 - Caparol SPECTRUM 4.0 - User Manual



5. PHOTOstudio

47

add/delete lines
You can use these functions to add or delete lines in corner grids (see chapter 5.2.6 “More tools - Grid” for 
information on corner grids).

5.2.7 retouch

The PHOTOstudio retouch functions allow you to correct your picture. It can be used to remove graffiti, 
clean dirty façade areas or duplicate construction elements, for example.

Retouch measures can be carried out on the entire picture or within individual components. To retouch the 
whole picture, tick the “Entire picture” field. To retouch individual components, leave this field empty and 
activate the respective component in the “Component” tab on the left. Before you start retouching work, 
make sure you have defined areas for your components (see chapter 5.2.4 “Tools: Area” for information on 
defining areas).
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You have different tools available for retouching your picture.

Brush
The brush is ideal for soft contours, e.g. as shadow lines.  
For efficient use of the brush you can choose different brush tips under “Tool points”. Small tool points 
are particularly suitable for reinforcing lines by contour drawing. Areas can be filled quickly using large tool 
points. If the eyedropper is used to take a sample from the picture, the brush can be used for optimum 
retouching in the same spot. The brush can be used for freehand colouring in the selected area.
To select a colour for your brush, click the the small colour field next to the brush. A ColorPicker appears 
where you can enter an HSB or RGB value or select a colour from the range manually. Confirm your cho-
sen colour by clicking “OK”.

eyedropper
The eyedropper samples colour from the picture so that it can be applied with the brush. Select the eye-
dropper and click the desired location in the picture with the eyedropper. The sampled colour will then 
appear in the colour field next to the brush. You can use the brush to retouch the picture with the sampled 
colour.  

note: Choose smaller or larger tool points for exact retouching (see the chapter “Tool points”) and use the 
zoom function if necessary (see chapter 5.1.6 “View buttons”).
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stamp
Using the stamp tool, you can copy a section of the picture and assign it to another part of the picture. 
You can copy windows and insert them in a different place, for example, or replace dirty or “unattractive” 
picture areas by clean ones. 

1. Define the source point for the copy by holding down the “Ctrl” key and clicking in the picture at the 
same time. 
2. Now click on the area where you want to copy to, without “Ctrl” key, and start to click over the spot with 
the left mouse button. The contents are copied from the source point (blue circle) to the required spot, the 
target point (green circle). The distance between the source point and your first click at the target point is 
maintained over the entire copying process.

note: You can achieve good retouch results by using several clicks and/or several source points.

Pattern
The “Pattern” tool is used to adopt pattern structures in an area. To do this, click on the colour field next to 
the “Pattern” symbol and choose one of the eight patterns that appear in the selection window, e.g. grass, 
sky, gravel, asphalt. Draw the pattern directly into the selected component area - this is filled with the pat-
tern.
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gradient
You can create light-dark gradients on an area using the “Gradient” tool. This is useful to cover interfering 
objects, large areas of soiling or strong structures (bare brickwork etc.).
  Activate the component concerned, click “Gradient” and choose one of the ten gradient variants offered 
in the window that opens. When making your choice, heed the simulation of different light conditions so 
that as realistic impression as possible is created.

In addition, you can control the intensity of the gradient using the trackbar. Confirm the adaptation of the 
intensity by clicking again on the gradient previously selected to make the change visible in the picture. If 
you would like to use the intensity with the gradient, confirm selection by clicking “OK”.

Tool points
There are four differently sized tool points available in sizes 8, 16, 32 and 64 for optimum use of the 
“Brush” and “Stamp" tools. 

reset picture retouch
Choose “Reset picture retouch” to reverse the retouching work done.

shadow gradient
The “Shadow gradient” tool allows you to create your own shadow pattern for certain lighting situations for 
your rooms and façades.

note: A shadow gradient can only be created when a defined area is available.

To create a new shadow gradient, click the “Create” button and enter an unambiguous name in the dia-
logue window. Then click “OK” - the newly created shadow gradient appears in the shadow gradient 
window of the “Retouch” tab. In addition, a grid will appear in your workspace which you can position 
anywhere in the picture. This is used to shape the shadow gradient. Move the grid points and lines to the 
required position. 

To apply the shadow gradient, click the “OK” button (“Apply”) - the shadow is intensified (becomes darker) 
by clicking the “OK-Apply” button several times.
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You can create different shadow gradients according to this principle that are then listed in the shadow list. 
All the shadows created are listed by name in the field on the right - where they can be selected and then 
changed or deleted. 

If you would like to remove a certain shadow gradient, choose the respective gradient from the list and 
click the “Delete” button. The selected gradient is deleted from the list immediately.

5.2.8 colour settings

component brightness and component contrast
To correct brightness and contrast of a defined area, we recommend applying a test colour to the area 
(see “Test colours for areas”). 
The “Component brightness” trackbar allows you to adapt the brightness of areas of your picture with dif-
ferent exposures (e.g. façade areas in full sunshine or wall areas in deep shadow in rooms).
During design, the colours used are then correct when the test colour in the picture has the same bright-
ness as in the small test colour field.
You can use the “Component contrast” trackbar to change the contrast of areas (e.g. for diffuse picture 
areas). 
Changes to brightness and contrast trackbars are always related to the areas of the component currently 
selected.

note: Changes to brightness and contrast directly affect the colours and materials within the components 
- but not the original picture.

Test colours for areas
An area can be filled with a test colour to see if it has been correctly defined. There are five test colours 
(magenta, cyan, red, orange, green) available for this. Thanks to colour differentiation with different test 
colours per component, better orientation can be achieved in the picture. 
Choose the component concerned and then one of the test colours. All the areas belonging to this com-
ponent are not given this colour.

note: You should always check the brightness of the area using a test colour and correct it if necessary. 
The test colour in the picture must appear identical to the test colour field on the right. If the test colour 
chosen appears darker in the picture (e.g. if the wall in the original picture is not white), then adjust bright-
ness to the right. This is very important to prevent the colours used later for design being too bright or too 
dark. If you change the size of the area after you have added a test colour, your corrections will only be 
updated after you have clicked the test colour field again. Click the “X” underneath the test colours field to 
remove the test colour.

note: The test colours are overwritten during design and no longer visible.
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Test structure for grids
In order to check whether a grid has the correct perspective for later material design, it can be given a 
chessboard test structure first.  

The chessboard pattern is shown larger or smaller depending on the dimensions given (grid width and 
height). 
Important: The proportions are only correct when the test structure shows squares. To correct your test 
structure, enter more suitable dimensions for the grid and check them by clicking the “Test structure” but-
ton again. If you retain incorrect dimensions, the material used for design (wallpaper, spatula technique...) 
will not be shown realistically. Click the “X” next to the “Test structure” button to remove the test structure.

note: The test structure is only for fine adjustment of your grid for later material application - it is not vis-
ible in the actual picture during design.

5.3 Design images

As soon as all the areas and grids have been created for all the required components of your own image, 
you can start design in the PHOTOstudio. Library images can also be changed: You can change existing 
components with tools or supplement new components. (See chapter 5.1.1 “Import personal image” or 
chapter 5.1.2 “Load existing database image” on how to import images; see chapter 5.2 for image editing)
You can always change between editing the components (create areas, create grids etc.) and designing 
them (select colours and materials, colour areas etc.).

5.3.1 colour, material and favourites

select colour, material and favourites
You have the three tabs “Colour”, “Material” and “Favourites” available for selection of a colour or material 
collection. Here, you can navigate through the colours and materials collections as well as search for the 
products you require in your favourites (for colour/material search see chapter 4.2.2 “Colour” or 4.2.3 “Ma-
terial”, for information on creating favourites see chapter 4.3).
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colour
In the “Colour” tab you will find all the colours of the colour collections from Caparol, NCS and RAL for use 
for your designs. You can view a manufacturer’s collections list by clicking the 
“+” in front of the manufacturer’s name.
If you choose a manufacturer’s collection by mouse click, all the colours from this collection are shown in 
the “Design” tab on the basis of a list of colour fields.

material
In the “Material” tab you will find materials from Caparol as well as example materials from other renowned 
manufacturers for use for your designs with materials. Click the “+” in front of the manufacturer’s name to 
see the respective collection list.
If you choose a manufacturer’s collection by mouse click, all the materials from this collection are shown in 
the “Design” tab on the basis of a list of material fields.
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Favourites
In order to use one of your favourite colours or materials, click and select one of your set of favourites first 
from the “Favourites” tab. The selected favourites list is shown in the design area. To search through the 
colours or materials move the mouse pointer over the row of favourites cards. The patterns are accentu-
ated for a better view - click on such a pattern to select it for use in an image. If you have a long favourites 
list, you can also use the scroll bar at the bottom edge of the screen to view the contents.

„

note: Colours and materials can be used in the PHOTOstudio both for interior and exterior areas. Please 
check on the basis of the technical information sheets whether the material you have chosen can be used 
for the desired purpose in practice. (For technical information see chapter 4.2.3 “Material details”)
You will find further information about colours and materials in chapter 3.2.2 “Colour” and 3.2.3 
“Material”.

5.3.2  “Design” tab

In the lower area of PHOTOstudio you will find the “Design” tab, where you can select colours and/or ma-
terials for designing components in your image.

09/2010 - Caparol SPECTRUM 4.0 - User Manual

“Design” tab Extended search

Product feasibility

Colour preview

Colour selection

Brightness reference value

Page number in original kitColour trackbar

Favourites 

“Favourites” tab

Scroll bar



5. PHOTOstudio

55

colour trackbar
You can navigate through the currently selected colour selection using the colour trackbar. Click the 
respective point within the colour spectrum shown to select a colour range (red, yellow, green...) or move 
through the collection by dragging the trackbar with the left mouse button pressed. The colour selection 
jumps to the next colour kit when you click the arrow keys.

extended search/filter
To refine your colour and material selection you can filter according to brightness reference value, page 
number in the original colour kit, full text or product feasibility.

Brightness reference value
Enter a minimum and maximum brightness reference value to limit the brightness reference value. Then 
click the “Enter” key and only the colours in the required range are shown. This is helpful, for example, 
when a brightness reference value of 20 should be the minimum limit for façades with heat insulation for 
technical reasons.

note: Set the values in the brightness reference limits to “0” and “100” again to have all the colour fields of 
a collection shown.

Search for page number in original kit
To choose a certain page of the original colour/product kit of a collection enter the required number of the 
collection kit in the middle field. The colour field display jumps to the given page when you click “Enter”.
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Full test search
Enter the specific colour names that are contained in the selected collection. Enter “Gorse 110”, for ex-
ample, to use this colour directly, or just “Gorse” to be shown all the colours in the “Gorse” colour family. 
Click the “X” at the top right edge to return to the colour selection window. 

Product feasibility
The “Product feasibility” filter is at the top right edge of the colour selection window. You can use this to 
limit your selection to a certain basic material. You are then only shown the colours that can be produced 
in this product. 
If you would like to cancel the filter for a product, select “No filter” in the dropdown menu or just click the 
filter symbol. As soon as the red “X” is no longer visible, the filter restrictions have been cancelled and all 
colours are shown again, independent of their product feasibility.

Colour preview/colour selection
When you move the mouse pointer over the individual colour fields, the pattern the mouse is currently on 
is shown enlarged in the small preview window. As soon as you have selected a colour or material pattern 
by a single click, it also appears in the selection window above. A double-click on the pattern will make 
the “Material detail” window appear with further information. The last pattern selection chosen remains in 
the colour selection window until a new pattern has been chosen. The currently selected pattern can now 
automatically be used for designing an area.

colouring a component
When you have chosen a colour or material pattern and then move the mouse into the image, the mouse 
pointer appears as a paint bucket. When you click into an area, this is directly coloured with the pattern 
chosen. Alternatively you can click on the small square in front of the component name in the “Compo-
nent” tab and the respective image area is also coloured.
If you would like to change a component colour or component, simply click with the new pattern that you 
have chosen on areas directly in the image or on their component names. 
When you use a material, you can also choose the laying system and rotation of the pattern in the compo-
nent (see “Laying system and rotation”).
To remove colour from a component, right-click in the component and choose “Decolour component”. 

Colour preview

Description of selection 
(colour or material sample)

Colour selection
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note: Right-click a component to carry out further functions.

using colour/material for further components
In order to use the colour of one component for further components, drag the colour in the “Component” 
tab from one component to another by “drag 'n' drop”. Copy the colour of a component by clicking into 
its colour field. Then keep the left mouse button pressed and drag the colour field onto the desired target 
colour field of the other component. Release the mouse over the target colour field. The component areas 
are now also filled with this colour. 
If you still have the colour or material “in the bucket” you can simply click on the different areas in the im-
age to use it more than once.

laying system and rotation
You also have the options laying system and/or rotation of the material available for designs with materials 
(tiles, parquet flooring etc.). This allows you to choose between four different degrees of rotation and laying 
systems in order to align your material as you wish on a surface.

note: You can only change the laying system with some materials, e.g. parquet and laminate flooring.
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5.3.3 navigator

The PHOTOstudio navigator in the bottom right-hand area of the software shows a thumbnail representa-
tion of the workspace. The respective zoom section is displayed which helps towards better orientation. 

You can use the slide bar to change the size of your image by zooming in and out of the image (the actual 
size of the image is not changed). Alternatively you can enter a percentage figure and zoom the image in 
or out as required (100% corresponds to the full screen).
You can also zoom in and out by turning the mouse wheel on the active workspace (right-click into the im-
age to activate the workspace).

When you zoom into the image, this section of the image is shown framed in the navigator. Keeping the 
left mouse button pressed, you can move this zoom frame within the navigator view in order to navigate 
through the image in the zoomed workspace.
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